Design And Fabrication Of Low-Cost Electric Wheelchair For Elderly People

I.V.S.Yeswanth 2Dr.A.V.S.Sreedhar Kumar 3P.Shyam Chand, 4 U.Sandeep, 5P.Kalyan,
1 Assistant Professor, 2 Professor Department of ME, Narayana Engineering College, AP, India
2,3,4,5,6UG Students, Narayana Engineering College, AP, India

Abstract: Electric wheelchairs, also known as power chairs, are mobility devices designed to assist individuals with mobility impairments and aged people. Electric wheelchairs use a battery-powered motor to drive the wheels and are controlled by a joystick or other control devices like Smartphones. The project aims at developing a low-cost electric wheelchair that is capable of converting into a bed. The electric wheelchair is designed in Solidworks and electric wheelchair is fabricated with improved mobility capable of carrying a weight of 80-120kg with a speed of 5-8kmph. The purpose of this project is to create an electric wheelchair that is user-friendly, efficient, and cost-effective. The mobility of electric chair is achieved with the help of smart phone to help the movement of the disabled and elderly people. By combining Smartphone and Wi-Fi technology, Electric wheelchair that can be controlled wirelessly using a Smartphone and therefore solve the problem mentioned above since it is easy to move the wheelchair around without requiring too much energy. This project uses NODE MCU as the main controller to control the DC motor that is attached to the wheelchair.

Keywords: Solidworks, Electric Wheel Chair, NODE MCU

1 Introduction

In this modern era, it is true that recent developments of science and technology has drastically changed the way of a normal person lives his life but we also have to accept that there are certain groups of people who have not been benefit from this development. One particular handicapped people with have limited mobility and some elderly people are still living a miserable life.

The patent for a wheelchair with a folding X-brace frame was issued to two engineers named Everest and Jennings. Though previous chairs had been foldable top-to-bottom, the side-to-side folding position of the cross frame allowed the drive wheels to remain in place. This basic concept is still the standard for manual wheelchairs today. The first patent was issued for an electric wheelchair. Wheelchair frames made of aircraft quality aluminum were introduced to the market and started a revolution of ultralight wheelchairs. The technology has aided in the reduction of the overall weight of many types of wheelchairs [1]. Based on manual wheelchair. Prevents wheelchair from colliding with obstacles. Is compatible with multiple brands of wheelchairs and does not require any modifications to underlying power wheelchair. SWCS AT Sciences, U.S. Prevents wheelchair from colliding with obstacles. Is compatible with multiple brands of wheelchairs and does not require any modifications to underlying power wheelchair. TAO Applied AI Systems, Inc., Canada[2]. First VAHM built on modified mobile robot base. Three-level control architecture provided autonomous navigation (based on internal map) or two semi-autonomous behaviors (wall following, obstacle avoidance). Mode decisions made manually. VAHM uses multiple representations of environment (topological, metric) and IR beacons for path planning. Second VAHM based on modified power wheelchair. Uses same
three-level control architecture, mapping schemes, and IR beacons. VAHM provides autonomous navigation and semi-autonomous behaviors and mode decisions are made manually [3]. Earliest recording of a wheelchair, a Chinese engraving picturing a man in a chair with three wheels. Wheelchairs were well-developed in Europe and commonly found in drawings and literature. An electrically-driven wheelchair operating on a 12-volt battery and a 3/8 horsepower motor was used to give people rides. At the time it was not used for handicapped mobility but it did pave the way for future developments. Compact wheelchairs were developed using metal tubing instead of the traditional wooden components. The first electric wheelchairs were used for the handicapped. A battery and motor were applied to existing wheelchairs with a simple one-speed on/off switch. Sam Duke received a patent for a releasable add-on power drive applied to a manual wheelchair (the unit was actually permanently fitted to the chair with U-bolts) Folding wheelchairs were commonly fitted with electric drives. The drive units were still very heavy and quite difficult to put on and take off. At that point both joystick and steering column mechanisms were available [4]. The first appearance of wheelchairs in the United States. The chairs were of bulky wooden construction with two large drive wheels and two small caster wheels. The popular electric wheelchairs on the market are foldable though they require removal of at least the leg rests and batteries. Most electric wheelchairs on the market were still bulky, heavy, and required a special vehicle for transportation. The power components of the chair were integrated into the frame which has been strengthened to support them [5]. The Americans with Disabilities Act (ADA) and a growing awareness for the rights of the disabled have greatly improved research and design efforts in the assistive technology industry. Interest has also increased in this area due to the current trend toward the "graying of America" as the average age of Americans increases [6]. When mobility degrades with age, it is of great significance to develop devices which can support the elderly in their day-to-day life. With the usage of intelligent assistive robotic systems, elderly population can lead a better quality of life independently. This article is a review of various assistive devices for elderly focusing on mobility and self-transfer systems. The practical difficulties in walking and moving from bed to wheelchair or wheelchair to toilet seat affect the daily activities of aged people [7]. In hospitals, the evacuation of those with severe movement impairments can be highly problematic for the patients, for the staff and for other evacuees. It is critical to understand the performance of horizontal and vertical evacuation procedures, including the means by which people with reduced mobility can be assisted during stair descent. Micro-simulation modelling provides a useful tool to assess evacuation strategies, given the challenges of preparing and transporting patients in need of on-going care and the infeasibility of reality [8]. In this paper, a control method to improve the static stability of two wheeled wheel chair is proposed. The two-wheeled wheel chair is the wheel chair without caster wheels, and moves and stabilizes with only two wheels. It has good operability and capability to go over a step. However, two wheeled wheel chair has difficulty in statical stabilization because of the structure. In this paper, the steering system is introduced to the two-wheeled wheel chair. The effect of braking force from the higher inertia and the strain of tires are considered [9]. The root of these problems is the lack of mobility in the manual wheelchair design. Actually, a normal wheelchair contains a mass around 30kg and above. It becomes double when a patient sits on it. So, it will be though for the disabled people and also patients to move a wheelchair with load. Even the helper will feel tired to push the wheelchair with patient for a long time. Not only that, a wheelchair is only designed to sit and not to take rest. The sitting position of the wheelchair also cannot be adjusted. So, patients have to be shifted from wheelchair to the bed [10]. The research and analysis of motorized wheelchairs dates back in time with several scientists and researchers evaluating the stair climbing mechanism. Ghani et al investigate the control of a stair climbing wheelchair used for indoor purposes. This paper evaluates different stair climbing mechanisms
viz crawler type, leg type, hybrid type and wheeled type. The model of a stair climbing wheelchair based on two wheels is generated using MSC Visual Nastran 4D (VN) design software. The humanoid model is developed using requisite anthropometric data. Various forces and torques acting on the wheelchair while climbing the stairs are evaluated. Preferably, the outer support assembly comprises wheels on either side of the chair. An inner support assembly, closer to the center line of the chair, also supports the seat assembly [11]. has elaborated the background as well as recent developments in mobility assistive mechanisms while discussing the relative importance of stairs and wheels. These various types include 3 mobility scooters, track based stair climbers, clustered wheel concept and caterpillar wheel-based devices. A mechanism is proposed which is based on the use of four wheels. The rear wheels are autonomously driven and front wheels are freewheeling castors. This proposed concept is numerically modeled and power calculations for linear actuator are made. Stair ascent and stair descent operations are described along with figures and equations. The control system and the stair edge sensor system are also investigated. The stepping algorithm is discussed in detail. The influence of external factors like cost, weight, aesthetics, range of operation, safety, operational efficiency, comfort is evaluated. The track-based stair climber is also analyzed similarly [12]. investigated and summarized the evolution of wheelchairs over five years. Anthropometric parameters required to be considered for the design of seat ergonomically, a book on Indian anthropometric dimensions by Prof. D.K.Chakraborty is referred. Necessary measurements and data have been collected from Indian Anthropometric Design [13].

1.1 Problem Identification

- Physically disabled people face problems in moving with a manual wheelchair.
- A lot of energy wasted by the patient in operating manual wheelchair.
- The helper easily becomes tired by pushing the wheelchair with patient continuously.
- Elderly and disabled people get a backbone pain when always sit in a fix position.
- Patients cannot take rest on wheelchair and easily get injured while shifting to bed.

1.2 OBJECTIVES

1. To provide the facilities for disabled people and elderly people who cannot move properly.
2. To develop a wheelchair which can be controlled by Wi-Fi via Smartphone.
3. To reduce the burden of the people who push the wheelchair.
4. To improve the balance and posture stability of old age people.
5. The base of the electric wheel chair is modified such that it can accommodate the basic needs of the customer.

2. Design of Electric Wheel Chair

2.1 Design:

We Are designing our Wheel Chair using Solid works, as it is very reliable and easy to use.

Solid works is a popular computer-aided design (CAD) software application used for 3D modeling, simulation, and design of products, parts, and assemblies. It is widely used by engineers, designers, and manufacturers in various industries such as aerospace, automotive, construction, and consumer goods. With Solid works, users can create and modify 3D designs using a range of tools and features, including sketching, 3D modeling, assembly design, drawing, and simulation. The software also provides access to a large library of pre-designed parts and components, making it easier to quickly assemble complex designs. Solid works has a user-friendly interface, which enables users to easily
navigate and interact with their designs. It also supports collaboration and sharing of designs, allowing multiple users to work on a project simultaneously.

In addition, Solid works offers advanced capabilities such as finite element analysis (FEA) and computational fluid dynamics (CFD), which enable users to simulate and analyze the performance of their designs under various conditions. This helps to optimize designs and reduce the need for physical testing. Overall, Solid works is a powerful and versatile CAD software that can help users streamline their design and engineering processes and improve the quality and performance of their products.

![Figure 1: Isometric View of Electric Wheel Chair](image)

### 2.2 Calculation based on Weight of the Human Body

#### 2.2.1 Motor and Battery Requirement Calculations

Selecting an appropriate motor is extremely important as it is the powerhouse of the entire system. Considering its working environment, following would be the suitable parameters:

Since the wheelchair is designed to run in an indoor environment, the velocity can vary from 0.5m/s to 1.5m/s. We have considered the higher velocity of 1.5m/s. Also, the standard slope in Indian hospital environmental is 7.1°.

The total mass of the wheelchair = 125Kg. (self-weight = 25Kg, Load carrying capacity = 100kg) Radius of the wheel = 0.013m based on availability and cost.

Calculation of RPM of wheel:

The circumference of the wheel is the linear distance that will be covered in one revolution.

\[ 2\pi r = 0.08164m \]

1RPS covers 0.08164 meter in 1 second.

Therefore, for 0.08164 meter in 1 second,

\[ \text{RPS} = 0.94 \]

i.e., 56.39RPM \(\approx\) 57RPM

#### Case 1: Travelling on flat path:

Torque = (Push Force + Rolling resistance) * radius of wheel

Push Force is the minimum amount of force needed to start the motion of any automobile. It is given by the formula "m*a".

Rolling resistance is the resistance offered by the tire due to its Visco-elasticity. It is given by the formula "umgcos α"

where \(u = \text{coefficient of rolling resistance} = 0.01\)
Therefore,
Torque = [(m*a) + (umgcos α)] *r = (43.5+16.22) *0.254 = 16.66 Nm
Consider Factor of Safety (FOS) = 1.5, Torque = 28.2 Nm i.e., 13Nm at each wheel

Calculating power required at one wheel:
Power = Torque* angular velocity (v/r) = 11 * (1.5/0.254) = 64.9 Watt

**Case 2: Inclined path**

While travelling on an inclined path, the wheelchair will experience some Gradient Resistance. The Free body diagram for this condition can be illustrated in Fig. 1 Gradient Resistance is the resistance offered on slope due to gravity. It is given by the formula "g sin α" Considering that the gradient resistance will tend to oppose the motion, the velocity at slope decreases and the acceleration is almost zero. Therefore, push force becomes negligible.

Therefore:
Torque = (Rolling Resistance + Gradient Resistance) * Radius
= [(umgcos α) + (mgsin α)] *r
= [(0.01*145*9.81*cos7.1) + (145*9.81*Sin7.1)] *0.254

Torque = 48.24Nm
Considering FOS = 1.5; Torque = 72.36Nm i.e., 36.18Nm at one wheel

Power at one wheel = Torque * (v/r) = 36.18* (5.905) = 213.64 Watts

Since Case 2 requires more power, therefore designing for Sloped Path. Hence, selecting lorry wiper motor that has a power capacity of 250W, 12V and can run at 60 rpm. The maximum torque that can be achieved is 50 Nm. This motor can be powered by a 12V Lithium-ion battery.

### 3. FABRICATION OF ELECTRIC WHEEL CHAIR BASE

The electric wheel chair is fabricated with the help of aluminium as base material. We fixed plywood for seating purpose

*Figure 2: fixing wiper motor*
Figure 3: working of the project

Figure 4: Assembling Link Mechanism

Assembling 3 bar link mechanism to make the chair to convert into bed.

Figure 5: Connecting Circuits

Connecting circuits for the electrical wheelchair for automation.
Breakage occurred while testing actuators. We fixed this problem by using strong plywood and tested, it worked successfully.

6.2 Circuit Board

![Figure 8: Circuit Diagram](image)
3.1 Installing NODE MCU Board Manager

Starting with 1.6.4, Arduino allows installation of third-party platform packages using Boards Manager. We have packages available for Windows, Mac OS, and Linux (32 and 64 bit).

- Install the current upstream Arduino IDE at the 1.8.9 level or later. The current version is on the Arduino website.
- Start Arduino and open the Preferences window.
- Enter https://arduino.esp8266.com/stable/package_esp8266com_index.json into the File>Preferences>Additional Boards Manager URLs field of the Arduino IDE. You can add multiple URLs, separating them with commas.
- Open Boards Manager from Tools > Board menu and install esp8266 platform (and don’t forget to select your ESP8266 board from Tools > Board menu after installation).

![Figure 9: Adding Link in the Board Manager](image)

3.2 Code for Electric Wheelchair

/*New Blynk app with Home Automation Home Page

//Include the library files

#define BLYNK_PRINT Serial

#include <ESP8266WiFi.h>

#include <BlynkSimpleEsp8266.h>
// Define the relay pins
#define relay1 D0
#define relay2 D1
#define BLYNK_AUTH_TOKEN "" //Enter your blynk auth token char
auth[] = BLYNK_AUTH_TOKEN;
char ssid[] = "";//Enter your WIFI name char
pass[] = "";//Enter your WIFI password

// Get the button values
BLYNK_WRITE(V0) {
    bool value1 = param.asInt();

    // Check these values and turn the relay1 ON and OFF
    if (value1 == 1) {
        digitalWrite(relay1, LOW);
    } else {
        digitalWrite(relay1, HIGH);
    }
}

// Get the button values
BLYNK_WRITE(V1) {
    bool value2 = param.asInt();

    // Check these values and turn the relay2 ON and OFF
    if (value2 == 1) {
        digitalWrite(relay2, LOW);
    } else {
        digitalWrite(relay2, HIGH);
    }
}
//Set the relay pins as output pins

pinMode(relay1, OUTPUT);

pinMode(relay2, OUTPUT);  //</p>

Turn OFF the relay
digitalWrite(relay1, HIGH);

digitalWrite(relay2, HIGH);

//Initialize the Blynk library
Blynk.begin(auth, ssid, pass,
"blynk.cloud", 80);

} void loop()
{

//Run the Blynk library
Blynk.run();
}

3.3 Configuring Blynk App

3.3.1 Creating Account

1. Open your browser and search [https://blynk.io](https://blynk.io)
2. Open first link and click Login, it will direct you to new web page.
3. Create new account or log in with your credentials.

![Figure 10: Blynk dashboard](image-url)
3.3.2 Creating Template

1. Log in to your Blynk IoT account and navigate to the "Templates" section.
2. Click on the "Create new template" button.
3. Give your template a name and a description.
4. Choose the device type for which you want to create the template.
5. Select the type of widget you want to add to the template from the left-hand menu.
6. Drag and drop the widget onto the template canvas.
7. Configure the widget by clicking on it and adjusting its settings.
8. Repeat steps 5-7 to add more widgets to your template.
9. Once you have finished creating your template, click on the "Save" button.

![Blynk Template](image)

Figure 11: Blynk Template

4. Results and Discussions

Electric wheelchairs are quite costly are far from reach to the middle class. The paper focuses on details how to develop an electric wheel chair with reclining bed can be controlled using Bluetooth module. The overall cost of the project is around Rs. 35000/- which is almost half of the general cost of a electric wheel chair in market.

The project aims at modifying the existing wheel chair by adding more comforts for the users like reclining bed, space under wheel chair for carrying auxiliary items like emergency kits, BP machine, Medicine box, water bottles etc., The project also uses actuators for recline the wheel chair into bed, however to reduce the cost of electric wheel chair a link mechanism is used instead of actuators as use of actuators will increase the cost of electric wheel chair. Therefore by considering the people who find it difficult in buying the automated wheelchair, slight difference in the automated wheelchair have been made. We tried to reduce the cost of the wheel chair in the optimal ratio which will be helpful for the poor people. Wheelchair analysis was carried out both theoretically and practically. During the practical examination the weight of 120 kg was loaded and using a multifunctional wheelchair. The results of persons with different weight have been test and tabulated below.

**The Load Vs. Speed Graph:**
- The weight verses speed Graph is drawn for all the Team members as samples.
- On X-Axis the sample is represented with the respective weight in Kg's.
- On Y- Axis the Speed is represented in Km/Hr.
SCALE:
- On X-axis 1 Unit is equal to 10 Kg.
- On Y-axis 1 unit is equal to 1 Km/Hr.

<table>
<thead>
<tr>
<th>Sample</th>
<th>Weight Kg.</th>
<th>Speed Km/H</th>
</tr>
</thead>
<tbody>
<tr>
<td>P. Shyam Chand</td>
<td>45</td>
<td>8</td>
</tr>
<tr>
<td>P. Kalyan</td>
<td>50</td>
<td>7.8</td>
</tr>
<tr>
<td>U. Sandeep</td>
<td>60</td>
<td>7.5</td>
</tr>
<tr>
<td>G. Vamsi Krishna</td>
<td>75</td>
<td>7</td>
</tr>
<tr>
<td>Yeswanth</td>
<td>90</td>
<td>6</td>
</tr>
</tbody>
</table>

The only drawback, which is still desirable, is that high speed drives are not possible with this wheel chair. The electric wheel chair developed is manual. Since Arduino controller is used, it is open source and thus other assistive technologies can be further implemented to make this semi- and fully autonomous.

5. CONCLUSIONS

This project elaborates the design and construction of Electronic Wheelchair with the help of Wi-Fi Module. After designing the circuit that enables physically disabled to control their wheel using an android application in their smartphones and it has also been tested and validated. This proposed system contributes to the self-dependency of differently abled and older people.

This project work was carried on to fulfil the requirement of Major Project of Bachelor in Mechanical Engineering
6. REFERENCES

1. International Research Journal of Engineering and Technology (IRJET) - Electric Wheelchair for Physically Challenged P. Swapnis 1, Dr. B. Sharmila2, Y. Dharshan.


4. Jobby K. Chacko, DeepuOommen, Kevin K. Mathew, Noble Sunny, N. Babu

5. Richard Simpson, "The Smart Wheelchair Component System"]
   http://people.ece.cornell.edu/land/courses/ece4760/labs/2013/lab4.html


   http://dx.doi.org/10.1109/icsmc.1995.537920


